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Program Description:

This specifier application is designed to allow the end users of Omegaflex’s TracPipe to
quickly and easily design and size systems using the TracPipe product.

This application allows you to create systems, save these systems and re-open them later.
During the creation of a system you are prompted for information like the type of system
gas (natural gas or propane), system pressure, and system pressure drop. Once you
have created the system, you go about the process of adding items to the system. These
items are a regulator, connector such as a tee or manifold, or an appliance. To generate a
complete system, you create numerous items of these types. As you add an item to the
system you are prompted for information like the distance from the item it is being
connected to, the number of ports, or the appliance type and capacity. Once you have
defined these values the item is added to the diagram and a pipe and any necessary
fittings are generated.

After you generate the diagram of the system, you can calculate the piping sizes using the
‘Calculate Size’ command. This command determines the pipe sizes using the sizing
tables. Once the pipe sizes are determined the pipes are labeled with their size. During
the sizing process any regulator added to the system is also sized.

At any point during the process you can print the system diagram or generate a bill of
material. The bill of material will not include sizes if you have not calculated the sizes yet.
The bill of material can either be printed or saved to a PDF, XLS or RTF file format.

Features:

Installation package configured so that it is downloadable from a web site
Single meter systems only

Allows a mix of series and parallel in a single system
Unlimited appliances per system

Unlimited regulators per system

Unlimited manifolds per system

Sizeable dialog for ease of diagram creation

Right mouse click options on graphics

Print preview

Print of graphics in color or black and white

Bill of material output in PDF, XLS, or RTF

Ability to save and re-open systems to a .TPS file format.
Automatic regulator sizing
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Installation:

Software Requirements:

Operating System:
Windows 2000; Windows 98; Windows 98 Second Edition; Windows ME; Windows
NT; Windows Server 2003 Service Pack 1 for Itanium-based Systems; Windows
Server 2003 x64 editions; Windows Vista Business; Windows Vista Enterprise;
Windows Vista Home Basic; Windows Vista Home Premium; Windows Vista Starter;
Windows Vista Ultimate; Windows XP; Windows XP Professional x64 Edition;
Microsoft Windows NT 4.0 requires Service Pack 6a

Required Software:
You must also be running Microsoft Internet Explorer 5.01 or later

Hardware:

Same as operating system plus the following:
4.0 MB of hard disk space (minimum)

TracPipe Specifier for Windows User Manual
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http://www.microsoft.com/ntserver/nts/downloads/recommended/SP6/allSP6.asp

Installation Instructions:

1) From the Start menu, choose Run, and enter the path name and
TracPipeSpecifier.exe. For example, enter C:\ TracPipeSpecifier.exe.

2) When the welcome screen is displayed, choose next.

i TracPipe Specifier for Windows Setup

Welcome to the TracPipe Specifier for Windows
Installation Wizard

It iz ztrongly recommended that pou exit all Windows programs befare running this setup program.

Click Cancel to guit the zetup program, then close any programs vou have minning. Click Mext to
continue the installation.

WARMIMNG: This program is protected
by copyright law and international
treaties.

Unauthorized reproduction or

distribution af this pragram, ar any

portion of it, may result in severe civil

and criminal penalties, and will be

e e o e prosecuted to the maximum extent
1-800-671-8622 pozzible under law.

I et = ] [ Cancel ]

3) When the user information dialog appears, enter the user name for the computer
and the organization name. Choose whether this application is accessible for all
users on this computer or only the user who is installing the application. Choose
Next to continue.

i TracPipe Specifier for Windows Setup

Uszer Information
Enter the following information to personalize your installation. 1

Full Mame: ’E

Organization: |Synergis Technalagies, Inc.

The settings for this application can be ingtalled for the curent user or for all ugers that
share this computer. 'ou must have administrator rights to ingtall the zettings for all
users. Install this application for:

(3) Anyone wha uzes this computer
(3 Only far me [User)

Wize Ingtallation Wizard [R)

< Back ]I Meut » I [ Cancel
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4) The destination drive and folder where the program will be installed is listed. You
can accept the default or choose Browse to specify a different location. If you

specify a folder that does not exist the setup program prompts you before creating
it.

i TracPipe Specifier for Windows Setup

Destination Folder
Select a folder where the application will be installed. 1

The Wise Installation ‘Wizard will install the files for TracPipe Specifier for Windows in the
fallawing Folder.

Toinztall into a different falder, click the Browse buttan, and select another folder.

You cah choose not ta install TracPipe Specifier far Windows by clicking Cancel to exit
the Wise Installation YWwizard.

Destination Folder

C:\Program Files\OmegaflexhTracPipe Specifier for wWindowsh

Wise Installation Wizard [R)

[ < Back ]I et > ] [ Cancel ]

5) Everything is ready to install the software, click the next button.

iz TracPipe Specifier for Windows Setup
Ready to Install the Application
Click Mewxt bo begin installation. 1

Click the Eack button to reenter the installation infarmation or click Cancel bo exit

the wizard.

Wize Ingtallation Wizard [R)

< Back ]I Meut » I [ Cancel
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6) During the installation, the following progress screen is displayed.

i TracPipe Specifier for Windows Setup

Updating System
The features vou selected are cumently being installad. 1

wize Ingtallation \Wizard [R)

Cancel

7) When the installation is complete select Finish.

i TracPipe Specifier for Windows Setup

TracPipe Specifier for Windows
has been successfully installed.

Click the Finish button to exit this installation,

1-800-671-8622
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Uninstalling Instructions:

1) From the Start menu, choose Settings, and then choose Control Panel.

é Internet |~ } My Documents

Tnternet Explarer

. Ea My Recent Documents »
\gil E-mail

Qutlaok E:
i ﬁ My Pictures
“ M5H '\_j My Music
@ My Computer
@ ‘Windaws Media Player

4$ ‘Windows Messenger
Set Program Access and
= Defaults
@ Tour Windows XP '4‘:"_’315 Frirters and Faxes

Files and Settings Transfer
4 L 9) Help and Suppart:

Wizar
’
p Search

ERun...

All Programs D

@| Log Off |6‘ Turn OFF Computer

2) In the Control Panel, choose Add/Remove Programs.

B Control Panel

File Edit Wiew Favorites Tools  Help

Q Bark O @ p Search [B Folders Ev

Address G‘ Contral Panel

-ﬂ " Control Panel “ Pick a category

[ Swicch to Classic Yiew
r_' T
| @' Appearance and Themes " Printers and Other Hardware

See Also - =

& windows Update =
) Help and Suppaort | Network and Internet Connections v v User Accounts

o o e L { Date, Time, Language, and Regional
Dptions

- _J) Sounds, Speech, and Audio Devices [ Accessibility Options

_w Performance and Maintenance \ J Security Center

¢ My Computer
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3) On the Install/Uninstall tab in the Add/Remove Program Properties dialog box,
choose TracPipe Specifier for Windows, and click Remove.

4) Confirm you want to uninstall the application by clicking yes.

Add or Remove Programs

:\.’/' Are wou sure you want to remoyve TracPipe Specifier For Windows From your computer?

= I w ]

5) During the uninstall process, the following progress screen is displayed.

TracPipe Specifier for Windows

__El_ Pleaze wait while “indows configures TracPipe Specifier for
I i‘!#_-' WWindows

(3 athering required information...

TracPipe Specifier for Windows User Manual
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The Specifier Environment

Main Window

TracPipe Specifier - [TracPipe System1]
Fle Edt Tools Help (1)

BT IPTEYETE] PR e ISTEY (O
Bill of b aterial
@ Mumber Size | Length(ft.) | Load [METU] Fram To
Fi) e 10 1058 Meter Regulator
B 1] 105 Requlator  Manifold
C 3a" 20 5 Manifald  Lamp
0] 142" 25 100 Manifold — Fitting
@ E 142" 1 100 Fitting Boiler
Length Total: @]‘/‘,
348" an )
1 Lamp @ 142 26
5 MBTU Drop Zone
C D H@
20 ft. 25 ft, 9E (11)
/8 1/2 1 ft.
1,."’2"
® Boiler
A g, B ETeTe 100 MBTU
10 ft. o0 fr, e
/8" Fep-reG-3
() Feady..

1. Main Menu

2. Toolbars

3. Meter

4. TracPipe Segment
5. Regulator

6. Manifold

7. Fitting (Note: Selected objects, like this fitting, are displayed with a red rectangle surrounding them)

8. Appliance
9. Label
10. Bill of Material

11. Drop Zone

TracPipe Specifier for Windows User Manual
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Main Menu

The text items at the top of the TracPipe Specifier window are the main menu. Each main menu item displays a set
of related commands.

o File

e Edit
e Tools
e Help

Click a menu item to display the related commands.

Toolbars

There are two toolbars:
e Standard Toolbar

e  TracPipe Toolbar

The Standard Toolbar

Directly below the main menu, the Standard Toolbar allows you to perform the most common actions in TracPipe
Specifier.

3 5 0 e s o o

The TracPipe Toolbar

The TracPipe Toolbar is located directly to the right of the Standard Toolbar.

i L= A X e @
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Using TracPipe Specifier for Windows

Working with a TracPipe System

Creating a new system

To create a new TracPipe System from within Specifier for Windows
1. Display the New TracPipe system dialog box.
e Choose File * New....

e Click the New button. j

2. In the New TracPipe system dialog box, choose the system gas and system pressure.

Mew TracPipe System §|

TracPipe.
Specifier
FPlease specify the system parameters:
System Gaz
f* Matural Gaz

" Propane

System Pressure
* | ow Pressure
" Medium Prezsure

(" Elevated Pressure

|[Standard] Preszure 6" .C. Prezsure Drop D.E'W.Ij

Ok Cancel |

3. Click OK to create the system.

Note The drop down list provides options for pressures and pressure drops for the corresponding selected
pressure level.

TracPipe Specifier for Windows User Manual
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Opening a system

To open a TracPipe System from within Specifier for Windows
1. Display the Open dialog box.
e Choose File * Open....
e  Click the Open button. =
e Or, press Ctrl+O.
2. In the Open File dialog box, navigate to where the TracPipe system file is stored.

3. Select the TracPipe system file and click Open.

Note You can open recently used TracPipe system files quickly from the list at the bottom of the File menu.

Saving a system

To save a TracPipe System from within Specifier for Windows

1. Display the Save dialog box.
e Choose File * Save....
e Click the Save button. H
e  Or, press Ctrl+S.

2. In the Save File dialog box, navigate to where the TracPipe system file is to be stored.

3. Name the TracPipe system file and click Save.

Note You can save a copy of the active TracPipe system file by choosing File * Save As....

Closing a system

To close a TracPipe System from within Specifier for Windows

1. To close the current TracPipe system.

e Choose File * Close....

Iy
e Or, click the Close button.

TracPipe Specifier for Windows User Manual
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Printing a system

To print a TracPipe system
1. Open a TracPipe system to print.

2. Open the Print dialog box.

e Choose File * Print....

e Click the Print button. =

e  Or, press Ctrl+P.

3. Click OK.
Note To can change the paper size, system printer, orientation and margins prior to printing
e Choose File » Page Setup....
e Click the Page Setup button. A
Note To preview the system before printing
e Choose File * Print Preview....
e Click the Print Preview button. _:L

Note To print the system in grayscale

o Choose Edit » Options....

. Uncheck the Print in color checkbox.

TracPipe Specifier for Windows User Manual
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Modifying a TracPipe System

System Properties

To modify a TracPipe System from within Specifier for Windows
1. Display the System Properties dialog box.

e Choose File * System Properties....

e Click the Open button. G

2. In the System Properties dialog box, change the values that are not displayed in light gray.

Properties X
2= g
zLre | nformation [Standard) Preszure 6 .C. Preszure Drop 0.5 .C.
D ezcription [Standard] Pressure 6" _C. Pressure Drop 0.5"W.C.
Freszure Level LowPreszure
System [az MaturalGas
=
=
Footer
Header

Pressure Informabon
System prezsure information

3. In the upper, right corner of the System Properties window, click the Close button. a

Note The header and footer properties can be used to display information such as project name, company
information, system pressure and pressure drop, etc.

TracPipe Specifier for Windows User Manual
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Adding an Appliance

To add an appliance to a TracPipe System from within Specifier for Windows
1. Select a Meter, Regulator, Manifold, or Fitting

2. Make sure the Drop Zone is positioned where you would like the new appliance created.

Note Make sure the Drop Zone does not contain any other objects.

w

Display the Add Appliance dialog box using any of the following methods.
e Choose Tools * Add Appliance....
e Click the Add Appliance button. L

e Right mouse click and choose Add Appliance....

4. In the Add Appliance dialog box, choose the appliance type.

Add Appliance

Appliance Tope:

Appliance Load: [MBTU] | 0
Digtance from connected object: [ft) | 0

OF. Cancel |

5. Enter the appliance load in MBTU.
6. Enter the distance the appliance is from the connected object in feet.

7. Click OK to add the appliance.

Note The graphics displayed for the appliance will change depending on the appliance type selected.

TracPipe Specifier for Windows User Manual
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Adding a Regulator

To add a regulator to a TracPipe System from within Specifier for Windows
1. Select a Meter, Regulator, Manifold, or Fitting

2. Make sure the Drop Zone is positioned where you would like the new regulator created.
Note Make sure the Drop Zone does not contain any other objects.

3. Display the Add Regulator dialog box using any of the following methods.

e Choose Tools * Add Regulator....

e Click the Add Regulator button. * %
e Right mouse click and choose Add Regulator....

4. In the Add Regulator dialog box, enter the distance the regulator is from the connected object in feet.

Add Regulator,

Digtance from connected object: [ft] | [

1] Cancel |

5. Click OK to add the regulator.

TracPipe Specifier for Windows User Manual
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Adding a Manifold

To add a manifold to a TracPipe System from within Specifier for Windows
1. Select a Meter, Regulator, Manifold, or Fitting

2. Make sure the Drop Zone is positioned where you would like the new manifold created.
Note Make sure the Drop Zone does not contain any other objects.

3. Display the Add Connector dialog box using any of the following methods.

e Choose Tools * Add Connector....

T
e Click the Add Connector button. ==

e Right mouse click and choose Add Connector....

4. In the Add Connector dialog box, select the connector type of Manifold.

Add Connector

Caonnector Type: | b anifold A

MHumnber of outlet ports: 1

Digtance from connected object: [ft) | 0

OF. Cancel |

5. Enter the number of ports in the manifold.
6. Enter the distance the manifold is from the connected object in feet.

7. Click OK to add the manifold.

Note The graphics displayed for the manifold will change depending on the number of ports in the manifold.

TracPipe Specifier for Windows User Manual

16



Adding a Connector

To add a connector to a TracPipe System from within Specifier for Windows
1. Select a Meter, Regulator, Manifold, or Fitting

2. Make sure the Drop Zone is positioned where you would like the new connector created.
Note Make sure the Drop Zone does not contain any other objects.

3. Display the Add Connector dialog box using any of the following methods.

e Choose Tools * Add Connector....

T
e Click the Add Connector button. ==

e Right mouse click and choose Add Connector....

4. In the Add Connector dialog box, select the type of connector you would like to create.

Add Connector

Connector Tope: Tes -

Digtance from connected object: [ft) | 1]

OF. Cancel |

5. Enter the distance the connector is from the connected object in feet.

6. Click OK to add the pipe segment.

TracPipe Specifier for Windows User Manual
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Working with TracPipe System Components

Modifying a Pipe Segment

To modify the connection point of a TracPipe segment
1. Select a TracPipe segment.

2. Select the connector to be repositioned.

Note The connector is the large red square at the end of the TracPipe Segment.

D N
25 ft.

n E

1/2 1 ft.,

1;.-2||

Bailer
ﬂ 100 MBTLI

-y

3. Left mouse click and drag the connector away from the object it is connected to.

Note When a TracPipe segment is disconnected from an object it is displayed as an outline.

D —_—
o5 fr, E 'E
1/2 1 ft,
lllll.-zu
Boiler
2 100 METU
a0
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4. Drag the connector to the location you would like it to connect to and release the left mouse button.

Note Once you move the mouse over the object you are connecting to the connections point appear as white
X's. You must connect the pipe segment to the object at one of the white ‘X’ locations.

D
25 ft, ﬂ'aE
1/2 1 ft,
lllll.-Eu
Boiler
as 100 MBETL
s B

Moving a component

To move a component on a TracPipe System drawing
1. Select a Meter, Regulator, Manifold, Fitting, Appliance or Label

2. With the cursor over the component, hold the left mouse button down and drag the component to the new
location.

3. Once at the new location, release the left mouse button.

Note The location of a component may also be changed by modifying the component's properties dialog. Label
locations are modified through the corresponding component's properties dialog

Modifying a component

To modify a TracPipe System from within Specifier for Windows
1. Select a Meter, Regulator, Manifold, Fitting, TracPipe segment or Appliance
2. Display the Properties dialog box.

e Choose Tools * Properties....

e Click the Properties button. fl"‘

e Right mouse click and choose Properties....

3. In the Properties dialog box, change the values that are not displayed in light gray.

TracPipe Specifier for Windows User Manual
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Meter Properties

Properties X
5E 2
B
B
= 10
kY 10
Meter Type
Type af Meter

The location of the meter is the only property that can be changed. To change the other properties, use
System Properties.

TracPipe Specifier for Windows User Manual
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TracPipe Segment Properties

Properties X
BE 21
B
Length [Feet] 10
B
Dizplay style RightAngle jl
Start with vertical line True
B
From Paint 22.95
Label Location 32. 315
Label Vizible True
Ta Paint 121, 332
Display style
Contrals the stule af line representing the pipe

For a TracPipe segment, the following items may be modified:

The length in feet.

The display style of the TracPipe segment; either Straight or Right Angle.
Whether or not the TracPipe segment starts with a vertical line or horizontal line.
The start and end points of the TracPipe segment.

The label location.

Label visibility.

TracPipe Specifier for Windows User Manual
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Regulator Properties

Properties
5E 2
=
=
Label Location 93, 355
Label Vizible True
= 121
by 321
Label Locahon
The location of the label

For a Regulator, the following items may be modified:

The Regulator location.

The label location.

Label visibility.

TracPipe Specifier for Windows User Manual
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Manifold Properties

Properties X
Be 9
B
MHumber or ports z2
B
Label Visible True ~
bt 236
Y 325
LabelVisible
|2 the label vizible

For a Manifold, the following items may be modified:
e  The number of ports in the manifold.
e  The Manifold location.

e Label visibility.

TracPipe Specifier for Windows User Manual
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Fitting Properties

Properties

Be 9

B

B
Label Vizible True
= 356
kY 204

Fitting T ype
The twpe of fitting

For a Fitting, the following items may be modified:
e The Fitting location.

e Label visibility.
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Appliance Properties

Properties X
w5
Appliance Mame |
Appliance Type Boiler
Capacity [MBTL] 100
B
Label Location 397. 30
Label Vizible True
= 343
kY am

Appliance M ame
The name of appliance

For a Appliance, the following items may be modified:

e The Appliance name. If a value is entered here this name is displayed in the drawing and the bill of
material, instead of the appliance type.

e The Appliance type.

e The Appliance capacity in MBTU
e The Appliance location.

e The label location.

e Label visibility.
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Bill of Material Properties

Properties X
Be 9
B
= 176
kY 11
bt
The #-coordinate of the upper-left carner

The location of the Bill of Material is the only property that can be changed.

4. In the upper, right corner of the Properties window, click the Close button. a

Deleting a component

To delete a component from a TracPipe System within Specifier for Windows
1. Select a Regulator, Manifold, Fitting, Pipe Segment, Appliance, or Bill of Material

2. To remove the component

e Choose Tools * Delete.

Click the Delete button. x

Right mouse click and choose Delete.

e Press the Delete key on the keyboard.

Note Any components connected to the item to be deleted may also be deleted.

TracPipe Specifier for Windows User Manual

26



Calculating the System

To calculate the TracPipe segment sizes of a TracPipe System from within Specifier for
Windows

1. To calculate the TracPipe segment sizes

e Choose Tools * Calculate Size.
e Click the Calculate Size button. b@
Note The system does not automatically recalculate after modifications are made.

Note TracPipe segments that have a length of zero (0) are ignored.

TracPipe Specifier for Windows User Manual
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Working with the System Bill of Material

Displaying Bill of Material

To display the bill of material for a TracPipe System from within Specifier for Windows

1. To display the Bill of Material dialog box.

e Choose Tools * Bill of Material....

e Click the Bill of Material button. %

2. The Bill of Material Dialog is displayed.

Bill Of Material

Length (ft] | Load (METU] | From To |

........................................ 0 103 Regulator  Marifold
B 3" 10 105 beter R egulatar
C ama 2A 100 kanifold  Fitting
D ama 1 100 Fitting Bailer
E /e 20 5 Manifold  Lamp

Length Totals:

3. In the upper, right corner of the Bill of Material window, click the Close button.

TracPipe Specifier for Windows User Manual
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Export as text

To export the bill of material for a TracPipe System to a comma delimited text file.
1. Display the Bill of Material dialog box.

e Choose Tools * Bill of Material....

e Click the Bill of Material button. %

2. Export the Bill of Material as a text file.
e Click the Export as Text button on the toolbar. Iﬂ
= NE Rl

3. In the Save File dialog box, navigate to where the text file is to be stored.

4. Name the text file and click Save.

Export as spreadsheet

To export the bill of material for a TracPipe System to a spreadsheet file.
1. Display the Bill of Material dialog box.

e Choose Tools * Bill of Material....

e  Click the Bill of Material button. %

2. Export the Bill of Material as a spreadsheet file.

e Click the Export as Spreadsheet button on the toolbar. @
i (= 7 B

3. In the Save File dialog box, navigate to where the spreadsheet file is to be stored.

4. Name the spreadsheet file and click Save.

TracPipe Specifier for Windows User Manual

29



Export as PDF

To export the bill of material for a TracPipe System to a PDF file.
1. Display the Bill of Material dialog box.

e Choose Tools * Bill of Material....
e Click the Bill of Material button. %
2. Export the Bill of Material as a PDF file.

e Click the Export as PDF button on the toolbar. E
= BE R A

3. In the Save File dialog box, navigate to where the PDF file is to be stored.

4. Name the PDF file and click Save.

Place on system drawing

To place the bill of material for a TracPipe System on the system drawing
1. Display the Bill of Material dialog box.

e Choose Tools * Bill of Material....
e Click the Bill of Material button. %
2. Place the Bill of Material on the system drawing.
e Click the Place on drawing button on the toolbar. Q
= WET RNz
3. In the upper, right corner of the Bill of Material window, click the Close button. a
4. Move the Bill of Material to the desired location.

Note You can move the Bill of Material below the drawing and visible screen. The scroll bar on the right hand
side of the screen can be utilized to view the Bill of Material. Use the Print Preview command to view the Bill of
Material placement prior to printing.
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Specifier Options

To change options for the TracPipe Specifier for Windows

1. Display the Options dialog box.
e Choose Edit » Options....

2. The Options Dialog is displayed.

Options [‘SZ|

Label Dizplay

v Show Pipe Length

v Show Pipe Size

v Show Appliance Tupe

[v Show Appliance Capacity
Fipe Dizplay

v Frint in color

Label Appearance

Fant... 10 pt. Yerdana

Cancel

3. Choose which labels are to be displayed. A check mark indicates the label is displayed.
4. Choose whether or not you want to print in color.
5.

Click Font... to change the font for all labels.

This displays the font dialog.

Font gtyle: Size:
Regular 10 oK. |
.Y
iner Hand ITC B i 1 - Cancel

T Vineta BT 12
T visualll Bold Italic 14
() Vivald 15
€} Yladimir S cript = 18
() webdings hd 20 w
Effects Sample
[ Strikeout
[~ Underine AaBhYyZz

Scripk:

|Westem ﬂ

e Make necessary changes to font

e Click OK to save the changes to the font options.

6. Click OK to save the changes to the options.
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